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Enhancements and revisions in Adagio Ledger 9.

The changes and improvements to Adagio Ledger with this release are significant. To make it easier to review the various chan
have been made, we have grouped them by function in this release note. The Financial Reporter changes and improvements are
below, separately from General Ledger. 

Inquiries 

♦ The View Batch Status function now includes the ability to View batches (both open and posted, with multi
you to print Batch Listings (both open and posted, with multi
and Recover posted batches (with multi

♦ Added the ability to find transactions in the View Transactions function. The 
of a fiscal year and within that to pick a Batch, Entry and Detail #. 
fiscal year. Selecting from the smart finder

♦ Ledger now maintains an index into the posted transactions file
immediately in the View Transactions function
they used View Transactions to view entry details, then wait while the program generated an index. 
build TX inquiry index' on the Posting/Report tab in the Company Profile. If this option is on, the index is generated after 
batches, allowing immediate viewing of entries the next time you use the function
from prior versions. Having the option on 
network drive, or if you often post several batches individually, you may want to set the option to off. 
index is deleted by posting and generated when you open the View Transactions function if batches have been posted since the
last time the function was used. Set the option to on if generation of the index is fast enough 
longer post time in lieu of waiting when you wish to view entry details
whereas in previous versions, each user had to wait 

♦ The View Entry Details grid has been moved from a separate window opened by the 'View GL Entry' button, to the Account 
screen, allowing this information to be view

♦ When viewing transactions, the application name is shown beside the 2 character Application (source) code. For example, "Adag
OrderEntry" is shown for "OE". 

Edit Accounts 

♦ You can now restrict posting to an account by sub
function. A new tab will display. On this tab, select the sub
Ledger itself. Batch entry warns you if you create a
account is prevented if the restriction is make after the fact and an error batch will be created. Note: Entry and posting is
prevented in the sub-ledgers, only in Ledger itsel

♦ The format and entry of Account (and Department) codes can be controlled by several new options on the Options tab in the 
Company Profile. ‘Uppercase account codes?’ forces all codes to upper case. ‘Auto
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Enhancements and revisions in Adagio Ledger 9.1A (2013.05.23) 

The changes and improvements to Adagio Ledger with this release are significant. To make it easier to review the various chan
have been made, we have grouped them by function in this release note. The Financial Reporter changes and improvements are

The View Batch Status function now includes the ability to View batches (both open and posted, with multi
rint Batch Listings (both open and posted, with multi-select), print Posting Journals (open and printed, with multi

and Recover posted batches (with multi-select). 

Added the ability to find transactions in the View Transactions function. The Find Trans button opens a screen 
of a fiscal year and within that to pick a Batch, Entry and Detail #. The smart finder is used to search all 

inder result positions to the desired transaction in the grid. 

w maintains an index into the posted transactions file that allows the full Entry Details for a transaction 
in the View Transactions function. In previous versions, each user had to click the 'View GL Entry' 

ed View Transactions to view entry details, then wait while the program generated an index. There is 
build TX inquiry index' on the Posting/Report tab in the Company Profile. If this option is on, the index is generated after 

allowing immediate viewing of entries the next time you use the function. This option is defaulted on when converting 
Having the option on may significantly increase the time taken to post batches. For very large databases on a 

etwork drive, or if you often post several batches individually, you may want to set the option to off. When the option is off, the 
index is deleted by posting and generated when you open the View Transactions function if batches have been posted since the

Set the option to on if generation of the index is fast enough or you are prepared to wait for a 
longer post time in lieu of waiting when you wish to view entry details, otherwise set it off. The index is available to all 
whereas in previous versions, each user had to wait for an index to be built for them after clicking 'View GL Entry'.

The View Entry Details grid has been moved from a separate window opened by the 'View GL Entry' button, to the Account 
wing this information to be viewed immediately whenever a transaction is viewed. 

When viewing transactions, the application name is shown beside the 2 character Application (source) code. For example, "Adag

ct posting to an account by subledger(s). Click the new option 'Restrict to subledger' in the Edit Account 
function. A new tab will display. On this tab, select the sub-ledgers that are allowed to be posted to the account. The list includes 
Ledger itself. Batch entry warns you if you create an entry that is not permitted and the entry cannot be saved. Posting to the 
account is prevented if the restriction is make after the fact and an error batch will be created. Note: Entry and posting is

ledgers, only in Ledger itself. 

The format and entry of Account (and Department) codes can be controlled by several new options on the Options tab in the 
Company Profile. ‘Uppercase account codes?’ forces all codes to upper case. ‘Auto-fill account codes?' allows you to set all 
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The changes and improvements to Adagio Ledger with this release are significant. To make it easier to review the various changes that 
have been made, we have grouped them by function in this release note. The Financial Reporter changes and improvements are listed 

The View Batch Status function now includes the ability to View batches (both open and posted, with multi-select). It also allows 
, print Posting Journals (open and printed, with multi-select), 

button opens a screen allowing selection 
all transactions within that 

for a transaction to be shown 
the 'View GL Entry' button each time 

There is a new option 'Auto 
build TX inquiry index' on the Posting/Report tab in the Company Profile. If this option is on, the index is generated after posting 

This option is defaulted on when converting 
to post batches. For very large databases on a 

When the option is off, the 
index is deleted by posting and generated when you open the View Transactions function if batches have been posted since the 

you are prepared to wait for a 
. The index is available to all users, 

after clicking 'View GL Entry'. 

The View Entry Details grid has been moved from a separate window opened by the 'View GL Entry' button, to the Account 

When viewing transactions, the application name is shown beside the 2 character Application (source) code. For example, "Adagio 

(s). Click the new option 'Restrict to subledger' in the Edit Account 
ledgers that are allowed to be posted to the account. The list includes 

n entry that is not permitted and the entry cannot be saved. Posting to the 
account is prevented if the restriction is make after the fact and an error batch will be created. Note: Entry and posting is not 

The format and entry of Account (and Department) codes can be controlled by several new options on the Options tab in the 
fill account codes?' allows you to set all 
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account codes to the same length by automatically filling the entry field to the specified length. The fill character can be specified. 
An account code format can be used to make sure that new account codes conform to a company standard. The valid characters 
may include: 
 
 A – Uppercase alphabetic only “A-Z” 
 a – Upper or lowercase alphabetic only “A-Z, a-z” 
 B – Uppercase alphabetic only “A-Z” and blank 
 b – Upper or lowercase alphabetic only “A-Z, a-z” and blank 
 9 – Numeric only “0-9” 
 N – Uppercase alphanumeric only “0-9, A-Z” 
 n – Upper or lower case alphanumeric only “0-9, A-Z, a-z” 
 S – Uppercase alphanumeric only “0-9, A-Z” and blank 
 s – Upper or lower case alphanumeric only “0-9, A-Z, a-z” and blank 
 .  –  (period) Any case alphanumeric and “! - / ” 
 ~ –  (tilde) Any printable 
 _ –  (blank) for leading spaces 

♦ If you add an account that is likely set to the wrong type accidentally, for example adding a Balance Sheet account in the range of 
Income accounts, the warning "The account type of the previous and next acct/dept is different. Do you want to proceed?" is 
displayed. Note: If the Enforce Account Group Range option is on then it prevents you from doing this in the first place. 

♦ Added Excel Direct to the grid in the Edit Departments function. 

Batch Entry and Posting 

♦ When copying a batch you can now revise the batch name, saving you from having to rename it after copying. 

♦ You can now post to any year in the fiscal calendar that is open, rather than only to the 2 most recent years (either Current Year 
and Prior Year, or Next Year and Current Year). For example, this allows you to post an auditor's adjustments to the Prior Year 
after you have created the Next Fiscal Year. The 'To Prior Year' posting function is always available (provided it is enabled in the 
Company Profile). The fiscal year is now a drop-down field on the Posting dialog, showing all available years. Warnings are 
displayed if you post to a year more than 1 year prior to the current year. 

♦ The Spacebar now toggles the Ready to Post status on the batch grid. 

♦ Added the option 'Don't show this message again' on the confirming message when batches are set Read to Post, or Not Read to 
Post. 

Maintenance / Retrieve 

♦ Added the option 'Discard $0.00 trx' to the Retrieve Subledger Batches function. Set this option to discard zero amount 
transactions. 

♦ The original 'Recover' batches functionality was to be able to restore a deleted or posted Current Year batch, with no options for 
affecting the new batch. The Recover batch process now available within Batch Status inquiry allows for many different options for 
updating the batch, including reversing the entries. 

♦ The Purge Fiscal Year function now optionally removes accounts and departments that are no longer required after the fiscal year 
has been purged. In order for accounts to be deleted, the Opening Balance, Current Balance and Total Net Changes must be 
zero, and there must be no posted transactions for the account. Deleted accounts are logged in the Application Log, which lists 
deleted master records from all Adagio modules, and can be viewed with GridView. 

Reports 

♦ A 'Report set' button has been added to the toolbar. 

♦ Posting Journals can no longer be cleared after printing. This avoid accidental clearing (and there are no performance or space 
issues related to saving them). Posting Journals are cleared at year end. The 'Allow purge posting journal' option has been 
removed from the Company Profile. 

♦ Batch status information can no longer be cleared after printing the Batch Status report. Doing so prevents un-posting, reversing 
and recovering batches. Batch Status is cleared at year end. 

♦ Added the option 'Summarize by account' to the Trial Balance report. This prints one line for each account rather than one line for 
each Account / Department. 

♦ You can now create a Favorite report for posting journals even when there is nothing to print. 

♦ Added the %FPD option (Fiscal Period) for the Trial Balance and Detail Listing Report Favorite filenames for Adagio ePrint users. 
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♦ The legend line "e: Retrieved batch was edited." is now printed at the bottom of the Batch Listing report if you have edited entries 
in a retrieved batch and an 'e' appears beside the total for any entries. This avoids any confusion that such entries are in error. 

♦ When the GL Detail Listing is printed with the 'Page break on change of account' option enabled, the grand totals are printed on a 
separate page. 

Data Integrity Checker 

♦ The Data Integrity Check now reports an error if an account has the multi-currency option on but the database is not multi-
currency. This error caused problems when the Close Income/ Expense Account function was run. 

♦ The Data Integrity Check now detects a damaged fiscal calendar. 

General New Features 

♦ The Ledger program icon is more consistent with the look of other Adagio icons and the size of the "gl" letters has increased, 
making the icon easier to recognize at a glance. 

♦ New splash screen with an updated look.  

♦ In earlier releases of Adagio we added the ability for Excel Direct to create a CSV file for use by other spreadsheet applications, 
such as Apache OpenOfficeTM Calc, for sites that did not have Excel installed. The spreadsheet program was launched and 
opened the CSV file created. Excel Direct can now use Windows "automation" (inter-process communication) to send data to 
other spreadsheet applications, the same way it interfaces to Excel, allowing all formatting to be retained in the resulting sheet. 
OpenOffice 3.3 or later and LibreOffice® 3.3 or later are supported. This interface must be manually enabled. The file SSI2XL.INI 
must exist in \softrak\system and must contain the section [Initialization] with an entry <computer name>-UseOpenOffice=1, where 
<computer name> is the name of the machine that this entry references. Refer to the Readme Help for further details. 

♦ The Help | About function now has a Consultant tab showing the contact information for your Adagio consultant if they have 
enabled this option at your site. In addition, the About screen has been redesigned and includes a link to a documentation page for 
the module that shows New Features, What's New video and manuals. 

♦ When Ledger is opened after installing an upgrade, a dialog is displayed with a link to a short video highlighting the new features. 
The dialog is displayed for each user until they tick 'Don't show this message again'. The video also be viewed anytime by visiting 
the Softrak website. Note: the dialog also appears when Adagio is installed at a new site. 

♦ The Adagio menu now includes Ledger, allowing you to quickly open another instance of the program. 

♦ The F1 key now launches Help when no windows are open. 

♦ When sites with Adagio ePrint sign on to a new dataset for the first time, the question "Do you want to turn on Allow PDF printing 
for this dataset, and enable PDF Printing for all users? is now asked. 

♦ The Open Data screen can be sized horizontally to allow you to see the full data path. 

♦ The number of Previously Opened databases (saved by user) has been increased from 25 to 100. 

♦ The warning message "New date is more than one week later than old date. Accept new date?" on login now has the option 'Don't 
show this message again'. 

♦ The session date is now passed to GridView views (workspaces) loaded from the Inquiries menu. 

Problems Fixed 

♦ Editing a batch that has a mismatching amounts error, where the sum of the details do not equal the total on the batch header or 
the batch control, now displays a warning dialog that allows you to correct the mismatching amounts. The Batch Listing report also 
detects these problems. 

♦ When copying a batch that originated in Purchase Orders, the 'Recalculate period based on date' option did not work if batch 
contained comment lines.  

♦ When a batch was Unposted and the option 'Delete entries from posted?' was selected, the units were not increased/decreased 
by the unposting. 

♦ If a Retained Earnings account is set to post in 'Specified Currencies' and Next Year is open, posting a batch in the current year in 
a new currency will not be permitted until retained earnings is updated. 

♦ In the Edit Budgets and Edit Forecasts functions, when a filter was applied to restrict the accounts on the grid and the 
'Account/department sequence' option was used, if you clicked the 'By Department' option the underlying account grid 
repositioned to the end, thereby breaking the sequence for editing. 

♦ Corrected a problem displaying the grid showing the periods in the Edit Account Budgets function, that occurred in some cases 
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where a period became missing when the Next button was clicked. 

♦ The Alt-X key (vs. clicking the Excel Direct button) exported the grid contents to Excel even if user security prevented it. 

♦ On the Batch Listing report in Ledger 9.0D, when the 'Show Description' option was set to 'Primary', the Description 1 field partially 
wrapped onto the next line if was too long to fit in the available space on the report. 

♦ Printing a Report Set containing a statement group caused the program to hang if you had the Financial Reporter open. 

♦ If a fiscal year end is changed and a new fiscal year created, (e.g. 2012A), the title on the Trial Balance report did not print the "A". 

♦ When the Trial Balance was printed with the option 'Exclude zero balance accounts' (added for Ledger 9.0D), if an account had a 
zero balance prior to provisionally posting it was suppressed when it should not have been.  Note: if a provisional posting to an 
account that had a balance makes the new balance for that account zero, then the account will be suppressed. 

♦ The Batch Listing Report was remembering the range of Starting and Ending dates. They are no longer remembered, and instead 
are defaulted to Jan 1, 1980 and Dec 31 of the year 10 years from today. 

♦ In Ledger 9.0D, the Report Balance on the Detail Listing report was not zero in some cases. 

♦ When the Posting Journal was printed in 'Source and home' format, sorted by Account, any comment lines were printed at the top 
of the report instead of being suppressed. 

♦ The report filename codes (ex. %FYR) were not being saved in report favorites. 

♦ Import templates for Budgets, Forecasts, Net Changes, Statistics, and Source Currencies, no longer have the 'Add new records' 
option available because you cannot add new amounts to non-existent accounts. 

♦ The Import batch function now detects multi-decimal amounts in Excel import files (incorrect amounts that should only have been 
2 decimal) that previously caused rounding and data integrity errors. 

♦ The First Date field in the G/L Batch Control File was always blank when shown on the grid in the Batch Status function or in 
GridView. 

♦ When the Data Integrity Check reported an out of balance error in a batch, the error message had the debit and credit amounts 
backwards in some cases. 

♦ Installs an updated version of the Adagio Data Source (ADS) that corrects the OpLocks Setting shown in station log files 
<computer name>.log in \Softrak\System\StationLogs. It was reported as Enabled instead of Disabled in some cases. 

Financial Reporter 

New Features 

♦ You can drill down to the Entry Details for a transaction, showing both sides of the entry (unless consolidated). 

♦ Added new 'Value’ codes in the Account Data tree for many Groups. They output amounts without considering the fiscal period. 

♦ Added an optional Update parameter "U" to QUERYSHEET. It causes target sheet to be set to the fiscal period, department and 
year that was passed in. For example: QUERYSHEET(S, C [, F [, D [, Y[,U]) - if Update U is not zero set sheet S to the optional 
parameters F, D and Y. Note: sheet S cannot not have .AutoUpdate in cell A2.  

♦ Added new functions CURRENTFISCALYEAR(), NEXTCREATED(), NEXTFISCALYEAR(), and PRIORFISCALYEAR() to the 
right-mouse context menu under Insert Formula, Fiscal Information. 

♦ Added ‘Paste Format' and 'Clear Formatting' buttons to the toolbar. Use Copy and 'Paste Format' to copy the format without the 
content. Also added 'Past Formatting from Cell' (Alt-V) and Clear Formatting (Alt-DEL) to the Edit menu, and same choices on the 
right-mouse menu on a cell. You need to reset your toolbars after upgrading to show the new buttons. To do this, go to View | 
Customize, Toolbars tab, select Edit in the list and click the Reset button. 

♦ A 'Reset' option has been added to View | Properties to restore the original program values. 

♦ ExcelDirect now supports the Scaling options 'Fit columns to' and 'Fit rows to' options in Page Setup. 

♦ File names can be used in Hyperlinks and are sent to Excel. 

♦ The Window title now shows the "Maintain" or "Print" as the first word, depending on how the Financial Report was opened from 
Ledger. 

♦ Added 'Lock Toolbars' option to View | Customize | Toolbars. Prevents the toolbar from being moved or modified. 

♦ When creating a financial statement it hides the "Departmental Comparative" option in the Layout dialog if you are not using 
departments. 
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♦ When formatting dates, you can suppress leading zeros in the day and month elements by choosing “Precision 0” in the Format 
Type dialog. 

♦ Increased the period and year drop down to allow all periods and multiple years to be shown. 

♦ Added sample financial statements for updating the budget amounts using GLUpdate formulas. The GL!BudgetUpdate.sam 
statement allows entering an annual budget and amounts will be divided equally across all 12 fiscal periods. The 
GL!BudgetUpdateMonths.sam statement allows entering monthly budgets into columns and amounts will be written to the 
respective fiscal periods. 

♦ Added new the new ‘Values’ codes to the SuperSpec template and specification in the sample data. Updated the 
FunctionExamples and DateFunctionExamples. 

♦ A new sample financial statement (GL!DtlListing2.sam) has been added that allows you to quickly generate the transaction details 
for a non-contiguous range of accounts into an Excel spreadsheet. Instructions for its use are in the statement. 

Problems Fixed 

♦ The Clear Contents menu choice on the right-mouse menu on a cell now immediately clears the formula from the edit field on the 
toolbar. 

♦ VSUM displays the calculation correctly formatted. 

♦ Corrected the column number of Totals in drill down to Details view of posted transactions. 

♦  When using the “.RangeDept” SmartSheet command, the financial reporter now correctly ignores inactive departments if 'Ignore 
inactive accounts' has been enabled for the sheet. 

♦ Previously, you could not Copy cells when a SmartSheet was expanded. This has been fixed. 

♦ Printing a Statement Group no longer adds the individual statements to the “Most recently opened” list. 

♦ Enabled the arrow and Delete keys for non-generated cells in expanded smart sheets. 

♦ Editing a generated cell from the edit bar behaves the same way as F2 when a sheet is expanded. 

♦ GLFPS("OPEN") now correctly reports the beginning of the fiscal year. 

Enhancements and revisions in earlier versions of Adagio Ledger 

♦ Refer to the Readme help file for details of enhancements and revisions in earlier versions or Historical Enhancements under 
Products on Softrak's web site. 

Installing 

To install Adagio Ledger you need the serial number and install code from the download instruction email sent to you by Softrak 
Systems. 

If you are installing an upgrade, you need the upgrade serial number and install code from the download instruction email. A previous 
version of Adagio Ledger should already be installed on your computer before installing the upgrade. If a previous version is not already 
installed, you can still install the upgrade. After entering the upgrade serial number and install code, you will also have to enter the serial 
number and install code from a previous version. 

Read the section ‘Upgrading” sections below before installing an upgrade. 

If you are installing a Service Pack, you do not need to enter a serial number or install code. However, a previous version of Adagio 
Ledger 9.1A must be installed before the Service Pack can be installed. 

To install Adagio Ledger (or an upgrade), run the program file you downloaded. Once the install program is running, you can click the 
View button to open the Readme file for detailed instructions. If Adagio Ledger is installed on a network, you must also do a workstation 
install for each workstation running Adagio Ledger. Refer to “Installing on a network” in the Readme for instructions. 

To install the Adagio Ledger Service Pack, run the Service Pack program and follow the instructions on the screen. After installing the 
Service Pack, a workstation install may be required at each station running Adagio Ledger. To determine if a workstation install is 
required, start Adagio Ledger at the workstation. The workstation install will be automatically started if required. Note: If you are 
updating multiple applications at the same time, it may be faster to run the all workstation install to update all applications at once on the 
station. Refer to “Installing on a Network” in the Readme for instructions. 

Adagio Ledger 9.1A requires Adagio Lanpak (if used) to be version 9.0E or higher. 

Adagio Ledger 9.1A requires Adagio MultiCurrency (if used) to be version 8.1B or higher. 
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Adagio Ledger 9.1A requires a database conversion from 9.0B and earlier versions. You should perform a Data Integrity Check in your 
current version of Ledger before installing the new version and converting your database. Any errors should be rebuilt or dealt with in 
your current version to ensure a successful conversion. 

After converting a database to 9.1A or opening a database with 9.1A, the data cannot be used with earlier versions. 

Upgrading to Version 9.1A from 9.0D  Upgrade Complexity: Easy � 

There is no database conversion from 9.0D. The upgrade can be installed at any time. 

Ledger now maintains an index into the posted transactions file that allows the full Entry Details for a transaction to be shown 
immediately in the View Transactions function. In previous versions, each user had to click the 'View GL Entry' button the first time and 
each time they used View Transactions to view entry details, then wait while the program generated an index. There is a new option 
'Auto build TX inquiry index' on the Posting/Report tab in the Company Profile. If this option is on, the index is generated after posting 
batches, allowing immediate viewing of entries the next time you use the function. This option is defaulted on when converting from 
prior versions. 

Having the option on may significantly increase the time taken to post batches. For very large databases on a network drive, or if you 
often post several batches individually, you may want to set the option to off. When the option is off, the index is deleted by posting and 
generated when you open the View Transactions function if batches have been posted since the last time the function was used. Set 
the option to on if generation of the index is fast enough or you are prepared to wait for a longer post time in lieu of waiting when you 
wish to view entry details, otherwise set it off. 

Note that the new index is created by the conversion. This may take a significant amount of time (several minutes) for large databases 
on a network drive. 

To add the new buttons ‘Paste Format' and 'Clear Formatting' to the toolbar in the Financial Reporter, you need to reset your toolbars 
after upgrading. To do this, go to View | Customize, Toolbars tab, select Edit in the list and click the Reset button. 

Upgrading to Version 9.1A from 9.0C  Upgrade Complexity: Easy � 

There is no database conversion from 9.0C. However, some new SD data files (Report Sets, etc.) are created. 

A data dictionary change from 'Adagio Ledger 9.0A-9.0C' (@L90A) to 'Adagio Ledger 9.0D' (@L90D) was required in order to support 
new fields added for this version. GridView views created with the previous dictionary will continue to work without any change. 
However, you should convert your views to use the new ‘Adagio Ledger 9.0D’ dictionary. Views will convert perfectly, with no manual 
changes or adjustments required. 

Changes to the Crystal Reports for Adagio tables were not required for this release and thus no adjustments to custom reports are 
required. 

The format of the Statement Groups file has changed. As a result, previous versions of the Financial Reporter may crash when 
accessing a dataset that was saved with 9.0D. 

Upgrading to Version 9.1A from 9.0A or 9.0B  Upgrade Complexity: Easy � 

The settings made in the Column Editor for the View Transactions/Budgets function will need to be redone for Ledger 9.1A. 

The function User Preferences has been added under the File menu. It allows you to set certain options by user that were global in 
previous versions, including options previously found under File | Options, Reports | Report Options and from the Company Profile 
(company background color and On Start-up functions). The File | Options and Reports | Report Options functions have been removed. 
After upgrading to 9.1A and until individual user preferences have been set up for a user, all preferences originally set for the Adagio 
System Administrator, user SYS, will be used. 

The new Auto Advance option in batch entry does the same thing that turning on 'Auto add batch entry details' in File | Options did in 
previous versions, plus it auto-advances to the next detail when an entry is being edited. Therefore the original option has been 
removed and is not included in the new User Preferences function that includes the options previously found in File | Options. 

A function to 'Print Financial Statements' was added to the Reports menu in Ledger to allow you to print financial statement groups 
without opening Financial Reporter. You must open the Financial Reporter once using the Maintain Financial Reports function in the 
Maintenance menu and then reopen Ledger before the Print Financial Statements function is shown on the Reports menu. 

An ‘Ignore Inactive Accounts’ button was added to the toolbar in the Financial Reporter. If you are upgrading from version 9.0A or older, 
in order to view the new button, you need to reset your toolbars after upgrading. To do this, go to View | Customize, Toolbars tab, 
select each toolbar in the list and click the Reset button. 

To get the 'Lightning Bolt' and other buttons to appear that updates Budgets and Forecasts you have to reset the toolbar in the Financial 
Reporter. To do this, go to View | Customize, Toolbars tab, select each toolbar in the list and click the Reset button. 
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Upgrading to Version 9.1A from 8.1A or earlier  Upgrade Complexity: Difficult � 

Refer to the 'Upgrading to this Version' topic in the Readme help for details. 

-- end -- 


